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1.0 Preparation

Use the following procedure if you must reimage or restore a Windows 10 DXA
computer onsite followed by installing the same version of APEX software and other
ancillary software prior to the reimage to get system fully functional.

Caution:

& All data on the hard drive is destroyed once the disk restoration process begins. Only
qualified Hologic service engineers should perform this procedure. Be sure to
archive and save to removable media any scan files on the system. Also, create a
system backup and save custom report templates to removable media before
beginning the restoration procedure.

1.1 Prepare for the upgrade by performing the following
procedures on the APEX 5.6.x computer:

1. Log into the system as QDR.

2. Archive all unarchived scans on the legacy system.

3. Perform a System Backup to an external drive with at least 40 GB of memory.
4

Exit QDR without shutdown and close any other open applications visible in the
taskbar at the bottom of the screen.

5. Copy all the .Pxx., Rxx, and .Axx files from the C:\QDR\Data folder to a removable
drive.

Copy the C:\QDR\HxQuestionnaire folder to a removable drive.

On the removable drive, rename the HxQuestionnaire folder to
sitename_HxQuestionnaire_Legacy.

You may need these files later in the installation procedure.

8. Locate the HL7 Client running in the background (if present in the legacy version)
and take and save any screen captures of the configurations.

9. Make a copy of the C:\Program Files\Hologic\Physician’s
Viewer\Options\DxReport folder and save it to a removable drive.

10. On the removable drive, rename the DxReport folder to
sitename_DxReport_Legacy.

You may need files from this folder later in the installation procedure.

Note
(¥\  Record the name of the template that is being used in the Cover Letter Template field.

Note
(¥\  Remember that the path to the Win10 DX Report templates are now in the ...\Program
Files x86\... folder.

11. Log off as QDR and log into the system as Field Service.
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12. If present in the legacy version, make a backup of the DxReport files.

a. In APEX, go to the Utilities > System Configuration > Report > DxReport tab
and select Backup/Recover.

A

System | Analyze | DXApro Report | Archeve | HLT | Scan Conversion | History | DICOM | Privacy Tooks | Study |
General| WHO Critena | Least Sigrificant Change | BCA Repont | Dual Hip Repont DxReport |
Opbions Thresholds
¥ Inciude Summary Repor Incude ClassiiEalion  ioeeaokd  Thoea
¥ Include Cover Lattes
= [-1 [-25
= Display Header
™ Prompt for Filename F | 1 [-25
¥ Launch Word Upon Creation of Repor i E [25
# Beport Frachee Risk including PVA Frachees 1 | - | .
Cower Letter Template | C Program Files\HologicPhysi
Edt. | Defaur | r |1 25
Cutput Direciony | C¥Program Files\HologicPhys: r -1 |2
Edit. | Edit |
Repon Rues Intevpreting Physician
© Mome & [Dr. Frark =] Options.. || [Dr Frank =] Dekete |
[_BachupRecover_| Delete Reports |
L_OK | Cancel | Hep |

Figure 1: System Configuration Window, DxReport Tab
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b. In the System Configuration window, in the Backup section select Browse and
navigate to the removable media location and select Start to create the DxReport
b

System Configuration o]
Systen | Dicom Send Options | Dioom Gy Options | DiRepot Optiora  BsskugyRecover |

Baciag
Catart Ths oz beret 42w ot Bk e
R B

Erteer st flename for your backup e
[FiEEa1 76 S

Setect backup e 19 reccnoer

Select categunes
Figure 2: S i et
i+ Repan mules confguration
ystem W Riepon somplates and Carned fed
Configurati ML configuntion =
on
Backup/Rec
over oK Cancel Hep
Options
Window
13. Exit QDR without shutdown and close any other open applications visible in the
taskbar at the bottom of the window.

14. Record the legacy computer name and all network IP parameter settings.

MAN-09952 Revision 001, July 2023 Hologic, Inc. Page 6 of 34

600 Technology Drive, Newark, DE 19702 USA 1.800.447.1856
© 2023 Hologic, Inc. The information contained in this document is proprietary. Unauthorized distribution is prohibited.



Horizon DXA System Computers - Reimaging Windows 10 / Installing APEX v5.6.x
1.0 Preparation

1.2 Restore Windows 10

Caution:

& All data on the hard drive is destroyed once the disk restoration process begins. Only
qualified Hologic service engineers should perform this procedure. Be sure to
archive and save to removable media any scan files on the system. Also, create a
system backup and save custom report templates to removable media before
beginning the restoration procedure.

1.3  Boot Computer with Windows 10 Recovery Image Disk

Insert the Windows 10 Recovery Image Disk in the DVD drive.
Restart the system.

During the boot up process, press the ESC key to enter BIOS Setup.
Press F10 for BIOS Setup.

In BIOS Setup, use the arrow keys or mouse and select Advanced menu at top of
screen.

SO

6. Arrow down, select Boot Options, and press Enter (or select Boot Options with the
mouse).

7. Scroll down and ensure UEFI Boot Order is checked.
Scroll down and ensure Legacy Boot Order is unchecked.
Press ESC twice and select YES to save changes.
The computer reboots.
10. During the boot up process, press F9 to access the boot menu.
11. Select the UEFI DVDRW drive in the boot menu, and press Enter.
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14 Start Disk Restore

1. Depending on the model computer you are restoring, at the Clonezilla GNU Grub
screen, use the up and down arrow keys to select one of the following and press
Enter.

e For the HP G2 computer, select clonezilla live with img
G2_Win10_Ghost_<date> HP600 (default settings, VGA 800x600)

e For the HP G3 computer, select clonezilla live with img
G3_Win10_Ghost_<date> HP600 (default settings, VGA 800x600)

o For the HP G4/G5 computer, select clonezilla live with img
G4_Win10_Ghost_<date> HP600 (default settings, VGA 800x600)

The message ...the module is not found, overlays missing... is displayed.
(This message is normal.)
2. At the Are you sure you want to continue Y/N prompt, select Y and press Enter.
Be patient, as it may take a few minutes for this prompt in step 2 to display.
3. At the prompt for a second confirmation, select Y and press Enter.
The restore image process starts.

The Clonezilla GNU GRUB Operation Progress screen is displayed and shows the
operation progress until completion. The restore image process takes approximately
30 minutes to complete.

4. When the Choose Mode screen is displayed, remove the disk from the DVD drive and
use the arrow keys and select Power Off and then press Enter.

5. After the computer has completely shut down and powered off, reboot the system.
The system should reboot normally.
Note

(¥\  If the system boots up and the message Boot Device Not Found is displayed, then
complete the following steps; otherwise continue with 1.5 Set Up Windows.

a. Restart the system.

During the boot up process, press the ESC key to enter BIOS Setup and Press
F10 for BIOS Setup.

c. Use the arrow keys or mouse to select the Advanced menu at top of screen.

d. Arrow down, select Boot Options, and select Enter (or select Boot Options with
the mouse).

e. Scroll down and ensure UEFI Boot Order is unchecked.
f.  Scroll down and ensure Legacy Boot Order is checked.
g. Select ESC twice and select YES to save changes.

The computer reboots.
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1.5 Set Up Windows

To set up Windows on the DXA system computer:

1. Set the appropriate default settings for the country, language, keyboard layout, and
time zone for your location, and select Next.
Select Accept to accept the license terms and proceed to the next window.

If the connections window is displayed, select Unidentified Network to connect to
the network, or skip this step to connect to the network later.
4. Select customize in the next window, which is followed by three windows with

customization settings to select on each:

a. Turn off all settings on the first window which lists personalization and
location settings and select Next to proceed.

b. Turn off all settings on the second window which lists connectivity and error
reporting settings and select Next to proceed.

c. Turn off all settings on the third window which lists browser, protection, and
update settings and select Next to proceed.

5. Create a new user account named Admin on the computer:
a. Enter Admin for the username.
b. Enter password for the password.
c. Enter Hologic in the hint field and select Next.
Select Log Off.

6

7. Log into the system as Field Service.

8. Select Settings and select System.

9. In the System window, select Notifications & actions.

10. Turn off the option Get notifications from apps and other senders.

11. In the Settings window, select Open > Activation, (for Windows 10 activation).

12. Select Change product key to enter a Windows 10 Certificate of Authenticity (COA)
product key that is found on a sticker on top of the computer case.

13. An internet connection is needed for Windows activation.
If you do not have an Internet connection, you need to either:

*  Obtain a Wireless USB network interface device and use your iPhone as a
hotspot.

*  Bring the computer to an Internet-accessible location.

14. Close the Settings window.
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2.0 Install APEX 5.6.x Software

2.1 Install CommCon PCB and Drivers

S e

© X N>

11.
12.

13.
14.

With power off, reinstall the Hologic CommCon PCB if it was removed.
Reboot the system.

Log into the system as Field Service.

Insert the APEX Application DVD in the DVD drive.

On the keyboard, press the Windows logo and the pause key together to open the
System window and select Device Manager.

When prompted Do you want to allow the app to make changes?, select Yes.
Right-click on Other devices > Other PCI Bridge, and select Properties.
Select the Drive tab and select Update Driver.

Select Browse My Computer and select Browse.

. Navigate to the DVD drive and then to Apex System Software > Device folder and

select OK.
Ensure that the include subfolders checkbox is checked and select Next.

When the Windows Security popup window is displayed, select Install this software
anyway.
When the Hologic CommonCon PCB is recognized by the Windows, select Close.

Turn off the computer.

2.2 Install SQL Server 2012 Express Software
Install the SQL Server 2012 Express Software:

1.
2.

3.

Log into the system as Field Service.

Browse the APEX application DVD, double-click on the SQL Server 2012 Express
folder.

Right-click Setup.bat and select Run as administrator.

Note

(¥\  After the installation program begins, the progress of the SQL Server 2012 Express
installation opens in a command window. A message opens when the installation has
completed. The installation may take several minutes to complete, so please be patient.

4.

Reboot the computer.
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2.3 Install HP Printer Driver (if Required)
To install the HP Printer driver:

1. Log into the system as Field Service.
2. Install the printer driver only.

No other part of the printer applications should be installed.
3. Reboot the computer.

2.4 Configure the Network Connection
Configure the network connection:

1. Log into the system as Field Service.
2. Input the network configuration settings noted in Step 13 in Section 1.1 before re-
imaging computer.

3. Reboot the computer.

2.5 Install MS Word in APEX Reporting Engine for DXReport
Install MS Word 2016:

1. Log into the system as QDR.

2. Use the APEX Reporting Engine for DXReport disk to install the MS Word
program.

3. Use an Internet connection to activate the product key which is listed on a sticker on
the APEX Reporting Engine CD sleeve.

4. 1If you do not have an Internet connection, obtain a Wireless USB network interface
device and use your iPhone as a hotspot, or alternatively, bring the computer to an
Internet-accessible location.

5. Reboot the computer.
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6. To configure the MS Word 2016 trust center settings:
a. Open MS Word 2016.
b. Select File, and then select Options from the Sidebar.
The Word Options dialog opens.
c. Select Trust Center.
d. Select Trust Center Settings.
The Trust Center dialog opens.

e. From the Macro Settings section, select the Disable all macros except digitally
signed macros radio button.

f. Select Trusted Locations in the sidebar.

g. Verify that Program Files (x86)\Hologic is listed as a trusted location under
User Locations.
If it is not, then:

(1) Select Add new location.
(2) Browse to and select Program Files (x86)\Hologic.

Note
(N The Hologic folder does not exist until APEX is installed. Set this location after APEX
installation.

(3) Mark the Subfolders of this location are also trusted checkbox and select
OK.

h. Select Add new location.

i. Browse to and select Program Files (x86)\Microsoft Office\Officel6\Startup or:
Program Files (x86)\Microsoft Office\root\Office16\Startup.

The correct path is where the installer copied the HologicCT.dot,
HologicHX.dot, and HologicHL7.dot macro files.

j-  Select the checkbox Subfolders of this location are also trusted and select OK
and then select OK.
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2.6 Install APEX 5.6.x Software
To install the APEX 5.6.x software:

1. Log into the system as QDR.

2. Go to the APEX application DVD in the drive and locate Apex System Software
folder.

Double-click the folder.
Double-click Setup.exe.

The installation program begins, and the InstallShield Wizard window opens.

InstaliShield Wizard

APEX Setup it prepanng the [nstalS hedd® \Wizand, which wal
guede pou theouwsgh Hhe 1est of the setup process. Flaage wail

ENNEEERENEENENNEREEREERNERE | Cancel |

Figure 3: InstallShield Wizard Window

5. When the Welcome window opens, select Next.

Welcome to the InstallSheld Wizasd for APEX

Wielcoeme lo Hhe APEX Selup program. Thes program wall
install APEX on yous computer

Figure 4: Welcome Window
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6. When the License Agreement window opens, select Yes to accept the terms of the
agreement.

Plaage sead the hollowang kcente spresment canshally

Preay the PAGE DWW kiey to vee the real of the sgreemeant

HOLDGIC APEX SOFTWARE

fie] 1986 - 2015, Hodeoge, Inc
Al Fiaght

1+ Reterved

FOR USE PURSUANT TO HOLDGICS STANRDARD LICENSE TERMS

Do ywous accept o th Soime of the precedng Licenss Agresment 7 I pou choase No, the sahg
vill choge. T imatal APER pou st accepd this sppenment

< fack | Yo J Ho

Figure 5: License Agreement Window

7. At the Select Apex Machine Type window, select the appropriate APEX machine type
system (model) and select Next.

Seesct thee AFEX Machane hpe below

" DoNOT nstel APEX Software ™ DISCOVERY Syatems
™ WoddStation (* HORIZON Spstems
(™ EXPLORER System

™ QOHR-4500 Sysiems
" DELPHI Sysbams

Figure 6: Select APEX Machine Type Window
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8. When the Serial Number window opens, enter the system Serial # and Install Key
included in the options form in the upgrade kit and then select Next.

Eries the Senal nusmber of the machine and the instal Eey

Figure 7: Serial Number Window

9.  When the Choose Destination Location window opens (not shown), accept the
C:\ QDR folder as the destination location, and then select Next.

A progress bar is displayed while the program files are being installed.

10. The InstallShield Wizard Complete window opens with the Yes, I want to restart my
computer now option selected. Remove the APEX applications DVD from the DVD
drive and select Finish.

InstaliShield Wizard

IreetallS hield Wizard Complele

Setup hat Frehed instaling APEY on your compute

% “Waa. | wand i reslat ey computer now
™ Moo, | wall vethawt rnp comnpuben Lubes

Remowe any diskos from thea divves. and then click Frmb to
complete sehap

Frruth l

Figure 8: InstallShield Wizard Complete Window
The system reboots.
11. Log into the system as QDR.
12. Navigate to the APEX Task Bar and select Help > About APEX.
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13. When the About Hologic APEX Software window opens, verify that the correct
installed version is in the Version box and select OK.

About Hologic APEX

Hologic APEX Software
Version 56.0.7

Copyright (C) 1986 - 2015 Hologic Inc
All nghts reserved

HOLOGIC

This product is licensed to:

Customer Test
Model Harizon
Warning: This computer program is protected by OK |

copyright law and international freaties

Unauthorized reproduction or distribution of this
program, or any portion of it, may result in severe civil
and cnminal penalties, and will be prosecuted to the
maximum extent possible under the law

© Copyright 2012, Microsoft Corporation. Al rights A
reserved _Tech Suppoln !

Figure 9: About Hologic APEX Software Window

14. Create a System Backup.
Keep this backup aside for a blank database restore point if ever needed.

15. Enter any APEX Option Keys, for example, DICOM, Worklist...etc. included in the
options form in the upgrade kit, then exit APEX without shutdown.

16. Copy all the .Pxx, .Rxx, and .Axx files from the removable drive to the C:\QDR\Data
folder.

17. Insert the Apex Service Dongle (TLS-03999), launch APEX, go to Backup > System
Recover and recover the entire system backup created in Step 2 of Section 1.1 Prepare
for the upgrade by performing the following procedures on the APEX 5.6.x computer:

18. After the reconcile process completes, select Close.

19. Exit APEX without Shutdown.

20. Install any APEX options such as FRAX or HL7 Client if applicable.
21. Restore any custom templates or questionnaires.

22. Test system by performing daily QC and BCA QC (if applicable) and all operations
of customer workflow.

Caution:
& You may have issues printing before installation of the Windows 10 OS patches. The
patch installation resolves these issues.
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2.7 Install the Initial Windows 10 OS Patches

After completing a Windows 10 software only upgrade, the Windows 10 recovery utility
does not include the appropriate MS Windows 10 OS patches. It is required that you
update the system with these required patches.

2.8 Prerequisites

The Win10 OS patches and updater utility are compressed into an ISO file and can be
obtained from the Hologic Software Delivery Portal. You need to have an external USB
flash drive with at least 40 Gb of free space. The ISO file is very large, and it needs to be
downloaded prior to a site visit.

Note
You are not required to perform these updates monthly. You should however use the
& most recently released patches when performing the SW only upgrade or if the need
_ arises to re-image a Win10 computer on-site. Computers received from the factory with
Winl0 already installed, have the latest validated Win10 OS patches.

2.9 Complete the OS Update

Complete the Windows 10 OS update:

1. Download the WIN 10 OS patch file downloaded from the Hologic Software
Delivery Portal. The file has a .ZIP file extension.

2. Right-click the .ZIP file and select extract all. This creates a folder with the same
name as the .ZIP file and in that folder is the .ISO file.

3. Once you have the SFW-xxxxx.ISO file (SFW number changes monthly)
downloaded to the USB flash drive, right-click it, hover over 7-Zip, and select
Extract Files.

This unpacks the updater utility and the OS patches. Do not copy these files to the
DXA computer.

Log into the system as Field Service.
Exit APEX without shutdown.

On the desktop, start the Task Manager, and in the Startup tab, select QDR Main
Application and select Disable.

7. Navigate to the ISO extracted files folder, right-click the
Hologic.Installation. TopLevel GUILexe file, and select Run as Administrator to
begin the installation

8. If prompted, select Yes to allow execution.
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9.  When the Installation Task dialog box opens, ensure that all checkboxes are checked
under Installation Tasks and that Automatic Logon after Restart is enabled.

W Hostogic Ientallation. Topl evelGUI S i

Windows 10/2016 Updates
v08-14-2019

restakation Toskcs
B ek st Fepsressewits
EA et ot Flag:
] Wirdows Updates

Usemarme | DESKTOP-UDRIES Feid Serace INETALL
T — '
Figure 10: Installation Task Dialog Box

10. Enter the username and the password for the current logged in user and select
INSTALL.

During the installation, the system reboots a few times. This allows the system to
log back in without user intervention.

11. Allow the installation to complete.
This could take up to 2 hours depending on how many updates are required.
Note
(¥\  If atany time a failure occurs during the installation, select OK to acknowledge the
message that is displayed, and close any window that may have remained open. Start

the procedure over from Step 6 of Section 2.9 Complete the OS Update. The installation
resumes where it left off.

12. After the Installation Complete prompt confirms success, select OK.

13. Open Control Panel, select Programs and Features, select the link on the left side
labeled View Installed Updates, and confirm by date that the updates are installed.

14. Start the Task Manager and in the Startup tab, select QDR Main Application, and
select Enable.

15. Reboot the computer.
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3.0 Disable Windows 10 OS Processes and
Services

3.1 Disable the Microsoft Compatibility Appraiser

1. Log into the system as Field Service.
2. At the Search Windows prompt, enter TASKSCHD to open the Task Scheduler.

3. Select Task Scheduler.

(L) TaskScheduler
=/ pesktop app

B & b 0 8 == &

taskschd

Figure 11: Task Scheduler in Results Window
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4. Expand Task Scheduler Library > Microsoft > Windows and select Application

Experience.

(@ Task Scheduler - X
File Action View Help
= 2@ 8@
© Tesk Scheduler (Loca 21l eme Status  Triggers Net Run Time Last Run Time: LastRun f| | Actions
v [ Tosk Scheduler Library .
« I Microsoft @ Microsoft C... Disabled Multiple triggers defined  2/11/2020 3:4%:41 AM  2/5/2020406:27PM  Thelast ry | Application Experience -
" offee ProgramDat... Dissbled 2207201933727 PM The proce | 3] Create Basic Task.
« [ Windows @ StartupAppT... Disabled 11/30/1999 120000 AM Thetask H | o coeate Tack,
| NET Framework mport Tsk
| Active Directory Rights Management Services Client
| ApplD ) Display AllRunning Tsks
| Application Experience ] Enable AllTasks History
| ApplicationData
| AppDeploymentClent "} New Folder.
| Autochic X Delete Folder
| Bluctooth View N
| CertficateServicesClient
| Chidsk (al Refresh
9 ciip H +ep
| CloudExperienceHost
| Coneant < 5| | selected item -
Customer Experience Improvement Program Enable
- P P 9 General Triggers Actions Conditions Settings History (disabled) *
| Data Itegrity Scan . Epor.
| Defrag Neme: Microsoft Compatibilty Appraiser
-, Devielnformation Microsoft\Windows\ Application Experience o e
| Device Setup Location PP 3 K Deete
Author: Microsoft Corporation
| DeviceDirectoryClient P B wep
| Diagnosis Description: | Collects if opted-into P

| DiskCleanup Improvement Program.
| DiskDiagnostic

| DiskFootprint

7 busm

| eop

| EnorDetails

| Feedback

| File Clessification Infrastructure
| FileHistory

| LanguageComponentsinstaller
| License Manager

J Live

| Locstion Security options
1 Maintenance When running the task, use the following user account:
| Management NT AUTHORITV\SYSTEM
| Maps
| MemoryDiagnostic Run only when useris logged on
| Mobile Brosdband Accounts Run whether userislogged on or ot
7 MUl Do ot store password. The taskwill oy have access o locsl resources
Mutimedia
. Run with highest prvleges
I NetTrace 9 P i
1 Niasve Hidden Configure for: | Windows 10 .
| Offine Files
Pl vl e i

Figure 12: Select Application in the Task Scheduler Window

5. In the top center section, right-click the Microsoft Compatibility Appraiser and

select END.

(D Task Scheduler - B3
File Action View Help
= nm BE
© Task Scheduler (Local) 2 |l Name Status  Triggers Next Run Time Last Run Time | | Actions
~ [ Task Scheduler ibrary !
O Moot Microsoft Compatibilty Appraiser  Running _Multiple triggers defined 2/11/2020 341:55 AM _2/5/2020 406:2 [ RA QIS RS B
" offee © ProgramDataUpdter Dissbled 272672019337 | T Create Basic Task
v [ Windows @ StertupAppTask Disabled 11/30/1999 12
| NET Framework
| Active Directory Rights Mansgement Services Cl
7 ApplD [ Display All Running Tasks
| Application Experience ] Enable All Tasks History
| ApplicationData
| AppeploymentCiient
| Actochk X Delete Folder
| Bluetooth
| CertficateSenicesClient
Chkask G Refrsh
I Cip @ rep
| CloudbperienceHost
Conerant < 5| | selected tem =

b Run

n Create Task.
Import Task.

9 New Folder.

View »

7| Customer Bxperience Improvement Program
7 Data Integrity Scan

7 Detra Nome:  [Microsoft Compatiilty Appraiser

* ves ot prey op I e s
| Device Setup Location:  \Microsoft\Windows\Application Experience o,
7 DeviceDirectoryClient Author;  Microsoft Corporation

Generel Triggers Actions Conditions _Settings _ History (disabled)
u End

& Properties

| Diagnosis Description: | Collects e

| DiskCleanup T e i " X Delete
3 DiskDisgnosti B rep

1 DiskFootprint

- DUsM

3 eop

] Enoretas

] Feedback

] File Clasificaton nfrastructure
| FileHistory

1 LanguageComponentinstaller
1 License Monager

T tive

| Location

| Maintenance Security options.
| Management

| Maps.

| MemoryDiagnostic

| Mobile Broadband Accounts
MUl Run whether user i logged on or not

When running the task, use the following user account:
NT AUTHORITV\SYSTEM

Run only when user islogged on

| Muttimedia Do not store password. The task will only have access to local resources
- NetTrace
I Niasve

| Offline Files v Hidden

Run with highest privileges

Configure for: | Windows 10

Figure 13: Microsoft Compatibility Appraiser in the Task Scheduler Window
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6. Right-click the Microsoft Compatibility Appraiser again and select Disable.

(@ Task Scheduler

- X

Fle Acion View Help
&= nm B m
© Task Scheduler (Local) Triggers Next Run Time Last Run Time | | Actions
[ Task Scheduler Lirary Aoication B

© B Microsoft soft Compatibilty o o Multiple riggers defined_2/11/2020 3:41:55AM _2/5/20204:06:2 [ AL =TS -

7 Office gremDataUpdater 272872019337 ) Create Basic Task.
[ Windows ® StartupAppTask 1173011999 12

 NET Framework

I Active Directory Rights Management Services Cli
7 AppiD

| Application Experience

| ApplicationData

7 AppiDeploymentClient

7 Autochk

7 Bluetooth

7 CertficateServicesClient
7 Chidsk:

7 clip

7 CloudExperienceHost
7 Conexant

7 Customer Experience Improvement Program
] Data Integrity Scan
7 Defrag

7 Device Information
7 Device Setup
7 DeviceDirectoryClient
I Diagnosis

7 DiskCleanup
I DiskDiagnostic
7 DiskFootprint
7 pusm

7 e

7 ErrorDetails
7 Feedback

I File Clossification Infrastructure:
I FileHistory

I LanguageComponentsinstaller
7 License Manager

7 Live

7 Location

7 Meintenance

7 Menagement

7 Maps

| MemoryDiagnostic

I Mobile Broadband Accounts

I mul

7 Multimedia

7 NetTrace

7 Niasve

7 Offline Files

< >

General Triggers Actions Conditions Settings History (disabled)

Narme: Microsoft Compatibility Appraiser

Location:  \Microsoft\Windows\Application Experience
Author:  Microsoft Corporation

Description: | Collects program telemetry information if opted-in to the Microsoft Customer Experience
Improvement Program.

Security options
When running the task, use the following user account:
NT AUTHORITY\SYSTEM
Run only when user is logged on
Run whether user is logged on or not
Do not store password. The task will only have access to local resources

Run with highest privileges

Hidden Configure for: | Windows 10

& Create Tesk.
Import Task.

7 Display All Running Tasks

] Enable All Tasks History
New Folder.

Delete Folder

x

View »
(6 Refresh
H Hep
Selected Item -
b Run
» End
& Disable
Export.
i Properties
K Delete

H Hep

Figure 14: Disable Option in the Microsoft Compatibility Appraiser

7. Close the Task Scheduler and reboot the computer.
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3.2 Disable MS Word Hardware Graphics Acceleration

1. On the desktop, launch MS Word 2016 and go into File > Options.
In the left panel, select Advanced.

Scroll down to the Display section and put a check in the checkbox labeled Disable
hardware graphics acceleration and select OK and close Word Options.

4. Perform these steps for all the Windows logins on the computer.

Word Options ? be
G | - - "
e Font Substitution...
Display [ Expand all headings when opening a document .
Proofing Display
e Show this number of Recent Documents: 25 =d
Language O Quickly access this number of Recent Documents: |4
Advanced Show this number of unpinned Recent Folders: |20
Customize Ribbon Show measurements in units of: Inches =
Quick Access Toolbar Style area pane width in Draft and Outline views: 0"
O Show pixels for HTML features
Add-Ins . .
Show shortcut keys in ScreenTips
Trust Center Show horizontal scroll bar
Show vertical scroll bar
Show vertical ruler in Print Layout view
O Optimize character positioning for layout rather than readability
Disable hardware graphics acceleration
Update document content while dragging ‘i
Use subpixel positioning to smooth fonts on screen
Print
O Use draft guality
Print in background
[ Print pages in reverse order
O Print XML tags
[ Print field codes instead of their values
Allow fields containing tracked changes to update before printing
[ Print on front of the sheet for duplex printing
[ Print on back of the sheet for duplex printing v
oK Cancel
Figure 15: Word Options
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3.3 Disable Windows Defender

1. Log into the system as Field Service.

2. At the Search Windows prompt, enter GPEDIT, to open the Edit Group policy.

Best match

=

Desktop app

Edit group policy
e e

5 @ b 0 &8 == &

Edit group policy

Figure 16: Edit Group Policy
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3. Inthe left window panel, expand Computer Configuration > Administrative
Templates > Windows Components and select Windows Defender.

4. In the Windows Defender window double-click Turn off Windows Defender.

- x

A1 Windows Defender

Turn off Windows Defender

| Microsoft Secondary Authent
| Microsoft User Experience Vir

e 4 for mahware
and other potentially unwanted
software,

el > | etended (Standard

Figure 17: Turn off Windows Defender
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5. In the Turn Off Windows Defender window, select Enabled then select Apply and
then OK.

A Turn off Windows Defender O X

Ei Turn off Windows Defender B i Next Setting

(O Not Configured Comment:
(@) Enabled
() Disabled

Supported on: [ a¢ least Windows Vista

Options: Help:

This policy setting turns off Windows Defender.

If you enable this policy setting, Windows Defender does not
run, and computers are not scanned for malware or other
potentially unwanted software.

If you disable or do not configure this policy setting, by default
Windows Defender runs and computers are scanned for malware
and other potentially unwanted software.

Sy

Figure 18: Turn off Windows Defender Window

6. Reboot the computer.
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3.4

AN

Disable Windows Updates

Note
For Windows Updates to be installed, this service must be enabled, then disabled after
any updates are completed.

1.
2.

Log into the system as Field Service.

Right-click the start menu icon and go to Control Panel > Administrative Tools >
Services.

Scroll down and double-click Windows Update.

In the Windows Update Properties (local computer) window Startup type, select
Disabled.

File Action
e |FE HE » o8 nw

< Senvices (Local)

View Help

. Services (Local)

Windows Update Name Description  Status  Startup Type  Log On As ~
o €3 Windows Audio Manages au... Running  Automatic Local Service
escription: =
Enables e detection, download, and —4: Windows Audio Endpoint 8. Manages au... Running  Automatic Local Syste...
installation of updates for Windows 4 Windows Backup Provides Wi. Manual Local Syste...
and other programs. If this service is 5, Windows Biometric Service  The Windo... Automatic (T... Local Syste...
disabled, users of this computer will Windows Camera Frame Se... Enables mul Manual (Trig...  Lecal Service
net be ableto use Windows Update o oo Ceo e e A -
or its autematic updating feature,
and programs will nat be able to use s Windows Connection Mana... Mai Windows Update Properties (Local Computer)

the Windows Update Agent (WUA) &), Windows Defender Advanc... Win
API. €1 Windows Defender Networ,.. Helj o™ LoaOn | Recovery | Dependencies
£ Windows Defender Senvice  Hell oo ne v
‘€. Windows Driver Foundation... Crei
Windows Encryption Provid... Win| 0P meme:  Windows Update
& Windows Error Reporting Se... Al Dascpton [Enables the detection, dowrload, and nstalation of
) Windows Event Collector T bpdates for Windows and other programs. i this
€ Windows Event Log This oo o
at Windows Firewall Win | C:\Windows\system32\svchost exe k netsves
€} Windows Font Cache Service  Opt
£ Windows Image Acquisitio.., Proj  Statup ype: Diszbled e
£ Windows Insider Service wis
& Windows Installer Add
€ Windows License Manager.. POy 5o cote  Siopped
£ Windows Management Inst... Pro
£ Windows Media Player Net... Sha S
G Windows Mobile Hotspot S... Proy vy, can specify the start parameters that apply when you star the service
&) Windows Modules Installer  Enal  from here
Windows Presentation Fou...  Opt
& Windows Push Notification... Thi
&) Windows Push Notification... Thi
€% Windows Remote Manage..  Win
Windows Search : Pro Exc
&) Windows Time Maintains .- Disabled Tocal Service
) Windows Update Enables the ... Disabled Local Syste.
ELWinHTTP Web Proxy Auto~.. WinHTTPi.. Running  Manual Local Service
& Wired AutoConfig The Wired ... Manus! Local Syste.
L WLAN AutoCanfig The WLANS... Manusl Local Syste..
ELWMI Performance Adapter  Provides pe.. Manual Local Syste...
ork Folders This service Manus! Local Service
Gk Workstation Creates and.. Running  Automatic Network S...
ELWWAN AutoConfig This service .. Manual Local Service
&) Mbox Live Auth Manager  Provides au.. Manual Local Syste...
& Xbox Live Game Save This service ... Manual (Trig...  Local Syste...
&) Xbox Live Networking Service This service .. Manusl Local Syste..

'\ Extended f Standard

Figure 19: Disabled option in the Windows Update Properties (Local Computer) Window

5. Reboot computer.
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Caution:

& Installing the Windows 10 OS update reverts the MS Compatibility Checker to
“Running” if it was previously disabled following “TB-01650 Disabling Windows 10
OS Processes”. All settings performed in TB-01650 should be checked after Windows
10 OS updates are performed.

3.5 For HP ProDesk 600 G2/G3 computers only

Follow these steps to verify the NIC driver version:

1. Log into the system as Field Service.
2. Exit APEX without Shutdown.
3. At the desktop right-click the Start Menu button and select Control Panel.

Figure 20: Start menu

4. At the All Control Panel Items, select System.

[EH All Control Panel Items - o
4 [ » ControlPanel » All Control Panel ltems > v/ 0] | search Control Panel £
Adjust your computer's settings Viewby: Smallicons =
& (32bit) 55 Administrative Tools. ) Audio Controls [ AutoPlay
8 Backup and Restore (Windows 7) 8% BitLocker Drive Encryption I Color Management Credential Manager
9 Date and Time [ Default Programs. o Device Manager
=1 Display @ Ease of Access Center File Explorer Options.
Flash Player (32-bit) A Fonts
[F Infrared 2 Intel ® Graphics Settings
€2 Language @ Mouse
[ Phone and Modem 3 Power Options
& Region % RemoteApp and Desktop Connections
& Speech Recognition £ storage Spaces [ system
[l Taskbar and Navigation [ Troubleshooting KB Windows Defender
WP Windows Firewall s Windows To Go [ Work Folders

Figure 21: All Control Panel Items window
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5. In the System window, select Device Manager.

2 System

Control Panel Home

& Device Manager

§ Remote settings

G System protection

& Advanced system settings

Security and Maintenance

< © 4 5 Control Panel

> All Control Panel ltems > System

View basic information about your computer
Windows edition

Windows 10 Enterprise 2016 LTSE

© 2016 Microsoft Corporation. All rights reserved

System
Processor. Intel(R) Pentium(R) CPU G400 @ 3.30GHz 3,31 GHz
Installed memory (RAM):  8.00 GB (7.88 GB usable)

System type: 64-bit Operating System, x64-based processor
Pen and Touch: No Pen or Touch Input is available for this Display

Computer name, domain, and workgroup settings
DESKTOP-UDRIE)
DESKTOP-UDRIIES

Computer name:
Full computer name:

Computer description:
Workgroup: WORKGROUP

Windows activation

Windows is activated Read the Microsoft Software License Terms

Product ID: 00380-71600-12584-AA0EM

v O | Search Control Panel

o

o= Windows10

@ Change settings

®Change product key

Figure 22: System Window

6. In the Device Manager window expand Network Adapters.

& Device Manager

File  Action View Help

e @ E HR B EXE

a

x

5 Firmware

[ Monitars

~ @ DESKTOP-UDRIIEJ
i Audio inputs and outputs
[ Computer
- Disk drives
& Display adapters
= DVD/CD-ROM drives

\@H) Human Interface Devices

== |DE ATA/ATAPI controllers

=2 Keyboards

m Mice and other pointing devices

v [ Network adapters

Ij’ Intel(R) Ethernet Connection (5] 1219-LM
I VMware Virtual Ethernet Adapter for VMnet1
7 VMware Virtual Ethernet Adapter for VMnet8

[E Portable Devices

& Ports (COM & LPT)

™ Print queues

) Processors

7 Security devices

B Software devices

i Seund, video and game controllers

S Storage controllers

E3 System devices

B lniercal Serial Bic contllers

Figure 23: Network Adapters in the Device Manager Window
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7. Right-click on Intel Ethernet Connection (<n>) 1219-LM (where <n> could be any
number) and select Properties.

r AQB asebcer acsbeen acsbeen:

Tile  Subtitle SubtleEm.. Emphasis IntenseE. <

sites

o Hor .
3 1DE ATAVATAPI
o

other pointing devices

(Opens property sheet for th

Figure 24: Intel Ethernet Connection Properties

8. In the Intel Ethernet Connection Properties window, select the Driver tab.

Intel(R) Ethernet Connection (3] 1219-LM Properties >
Events Resources Power Management
General Advanced Driver Details

[a—-! Intel{R) Ethemet Connection (5} 1215-LM
-

Driver Provider:  Microsoft

Driver Date: 4/5/2016

Driver Version: 1215226

Digital Signer: Microsoft Windows

To view details about the driverfiles.

Update Driver... To update the driver software for this device.
Disable Dizables the selected device.
Uninstall Te uninstall the driver (Advanced).
OK Cancel

Figure 25: Inter Ethernet Connection Properties Window

9. If the Driver Version of NIC driver is less than 12.17.x.x follow the Installation

instructions below to update the driver. Otherwise no further action is needed, and
this procedure is completed.
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3.6 Install NIC Driver

1. At the Hologic Software Delivery Portal,
https://hologic.sharepoint.com/teams/softwaredeliveryportal/SitePages/Home.aspx,
obtain a copy of the NIC driver SKELETAL HEALTH_NIC DRIVER FOR G2 AND
G3_WIN10 (SFW-03134).

2. Save to folder of your choice to your laptop (not the DXA computer).

Site Name *

Site Address *

FE Name (Type in Last Name and then select) *

Service Request From *

Hi{Salesforce) Cracle
Product
Skeletal Health -
Software
Skeletal Health Network Card Drivers *
Version
SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3_WIN10 (SFW-03134) ¥

Reason For Download *

Figure 26: Skeletal Health NIC Driver Version

The download instructions are emailed to you.
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3. At the Hologic Software Delivery Portal, HUB, User Guide window, select the link or
Download button.

The window advances to BOX.

Software Delivery Portal HUB  User Guide p
- ind days
==
e e it e 8 We're sorry, the preview didn't boad, ZIP files are not currently supported.
Figure 27: Hologic Software Delivery Portal HUB User Guide Window
4. Loginto BOX and select the Download button in upper right.
Vi SFW-03134_001_SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3_WIN10.zip (%0 Eers Download n %
[~
Figure 28: Skeletal Health NIC Driver download
5. At the bottom of the window, select the dropdown arrow next to Save to display to
open save options.
vi SFW-03134_001_SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3_WIN10.zip (% i ot m
(&)
]
I Do you want 10 open of save SEW-03134_001_SKELETAL HEALTH_MIC AND G2 i ' n
Open S |v | Cancel R
Figure 29: Save to Display
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6. Select the Save as option and select the destination of your choice on your laptop.

Save
Do you want to open or save SFW-03134 001 SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3 WIN10.zip (396 KB) from dI2.boxcloud.com? Sos e

| open || Gave | | v Saveand‘upen I
Figure 30: Save As Option Window

The download file is zip file “SFW-03134_001_SKELETAL HEALTH_NIC DRIVER

FOR G2 AND G3_WIN10.zip”.

7. Navigate to the folder where you saved the zip file and right-click the file “SFW-
03134_001_SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3_WIN10.zip”
and hover your cursor over 7-zip and then select Extract Here.

b Fokdbar - i @
WO 0L _SIELET Open !'-l-’--.w

Opar on mew sarcdow
Entect A |
T-Ig ¥ e i Pk
RO A v Oipen arthivr

o ik it Botapads = st Fien
Chpom wath C lem.&
Fleniig prdwaiat s Eameaect b “SFWETL 3 0 SFART AL HEAL TR I [RR FOR G2 AHD 63 WRANF
Sandte - Tt sachiv

B by A Pyt

Ca [ FE———— p—
Cowy Bk bo “SPR-DTL 00 _SCTLITAL MLALTH_REC DENTR FOR G2 AND GI WML
Craatn thosiodd Ciwmgieis W "EON-OTLH 00 FRELETAL HEALTH MIC DRIVER FOS G NG G WRGRTE" arell avmad
Coabits Coempress to: “SFW 030 1 008 SKELFTAL HEALTH MC DRIVER FOR G AND G WiNDS.sp" aned emai
R e
e I -

Figure 31: Extracting Files
This creates a folder with the same name as the zip file “SFW-
03134_001_SKELETAL HEALTH_NIC DRIVER FOR G2 AND G3_WIN10”.
Copy this folder to your USB flash drive.

On the DXA computer, log into the system as Field Service, and exit APEX without
shutdown.

10. Insert the USB flash drive and copy the driver folder “SFW-03134_001_SKELETAL
HEALTH_NIC DRIVER FOR G2 AND G3_WIN10” to the DXA computer desktop.

11. Open the folder SFW-03134_001_SKELETAL HEALTH_NIC DRIVER FOR G2
AND G3_WIN10 and right-click the driver file sp99053.exe and select Run as
Administrator.
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12. When the User Access Control dialog opens (not shown), select Next.

13. At the Intel 1219 NIC Driver window select Next.

) Intel 1219 NIC Driver

TITLE: Intel 1219 NIC Driver ~
VERSIOM: 12.18.9.7

DESCRIPTION:

This package provides the Intel Network Interface Card
Drivers for supported desktop models running a

supported operating system.

PURPOSE: Routine

SoftPag MUMBER: SP95053
SUPERSEDES:SP93573,Mone
EFFECTIVE DATE: 8/28/2019
CATEGORY: Driver - Metwork
S55M SUPPORTED: Yes

LANGUAGE(S):

English (US)

French

German

Spanish

Italian

Swedish

Portuguese W

Figure 32: Intel 1219 NIC Driver Window

and select Next.

) Intel 1219 NIC Driver

License Agreement
Please read the following license agreement carefully.

PLEASE READ CAREFULLY: THE USE OF SOFTWARE AVAILAELE AT THIS SITE IS SUBJIECT »~
T THE TERMS AND COMDITIONS THAT FOLLOW, IF YOU AGREE TO THESE TERMS,

PLEASE CHOOQSE THE "I ACCEPT” OPTIOM LOCATED ADJACENT TO THE SCREEM WHERE
ITHIS AGREEMENT IS DISPLAYED. IF YOU DO NOT AGREE TO THESE LICENSE TERMS,
PLEASE CHOOSE THE "I DO NOT ACCEPT” OFTICON AND DO MOT DOWNLOAD ANY
SOFTWARE FROM THIS SITE.

End-User License Agreement

READ CAREFULLY BEFORE USING THIS EQUIPMENT.

This End-User license Agreement ("EULA") is a legal agreement between (a) you (either

an individual or a single entity) and (b) HP Inc. ("HP") that governs your use of any

Software Product, installed on or made available by HP for use with your HP product ("HP
Product”), thatis not otherwise subject to a separate license agreement between you

and HP or its suppliers, Other software may contain a EULA in its online documentation, %

(@1 accept the terms in the license agreement!

(7)1 do not accept the terms in the license agreement

Figure 33: License Agreement Window

14. At the License Agreement window, select I accept the terms in the license agreement
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15. At the Location to Save Files window, leave the default file location and select Next.

() Intel 1219 NIC Driver *

Location to Save Files
Where would you like to save your files?

Please enter the folder where you want these files saved. If the folder does not
exist, it will be created for you. To continue, dick Next.

Save files in folder:

| - \5WSetup\SP99053

Change...

Figure 34: Location to Save Files Window

16. A command window opens briefly and exits.
Installation is complete.
17. Reboot the system.

18. Repeat section 3.5.1 Follow these steps to check the NIC driver version to verify that
the NIC driver version is 12.18.x.x.
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